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1. General Concepts 

1.1  Introduction 

InTouch Machine Edition enables a line of sight from Wonderware System Platform 
SCADA applications down to embedded machine-based small systems. Configure 
remote machines directly from System Platform. 

Monitor machine status and performance against OMAC PackML data and OEE 
(Overall Equipment Effectiveness) standards. Changes implemented in the InTouch 
Machine Edition applications update automatically to System Platform SCADA 
applications. 

 Leverage your Wonderware System Platform investment by sharing data from 
embedded devices across multiple plants 

 Native integration with Wonderware System Platform and Wonderware Historian and 
Wonderware Online facilitates easy, cross-site reporting and performance metrics 

 Native System Platform integration with InTouch Machine Edition enables collection, 
historization of tag values and alarms status without impacting existing System 
Platform licensing 

 Tiered architecture facilitates IIoT based applications that will demand surge in the 
volume of interconnected devices 

 Ability to centrally deploy InTouch Machine Edition projects to connected remote 
nodes from System Platform 
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2. Installation and Licensing 

2.1 Installation 

To install and run the full InTouch Machine Edition HMI software, you must have the 
following:  

 A Windows-compatible computer with a standard keyboard, a pointer input (i.e., a 
mouse, trackpad, or touchscreen), and an SVGA-minimum display;  

 One of the following Windows operating systems: 

 Windows Server 2016  

 Windows Server 2012 R2  

 Windows Server 2008 R2 Service Pack 1  

 Windows 10 (including LTSC/LTSB versions)  

 Windows 8.1  

 Windows 7 Service Pack 1  

 Windows 10 IoT Enterprise (LTSC/LTSB version only)  

 Windows Embedded 8.1 Industry Pro (formerly known as Windows 
Embedded Standard 8)  

 Windows Embedded Standard 7 Service Pack 1  

 .NET Framework 3.5 and .NET Framework 4.7  
 Internet Explorer 11 or later 
 2 GB free storage  
 1 GB free memory  
 An Ethernet or Wi-Fi network adapter. 
 Other Recommendations. 

 Firewall off. 

 User Account control (UAC) Disable. 

 Administrator Login. 

 Password policy 
 0 days expire 
 Complexity Disable 

 

2.2 Licensing 

 Types of License 

 

 Evaluation Mode  
Enables all of the product's engineering and runtime features.  

The first time you install InTouch Edge HMI on a computer, the product runs for forty 
(40) hours in Evaluation Mode. This evaluation period includes any time you run a 
product module (engineering or runtime). You can use this evaluation period 
continuously or not; for example, 10 hours a day for 4 days, or 5 hours a day for 8 

days, or 10 hours a day for 3 days plus 5 hours a day for 2 days, and so on.  
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After running for 40 hours in the Evaluation Mode, the evaluation period ends and the 
program automatically converts to Demo Mode until you apply a valid license. You 
cannot reactivate Evaluation Mode, even if you reinstall the software on your 

computer.  

 Demo Mode  
Allows you to download projects to remote stations and to run projects for testing or 
demonstration purposes. You can execute runtime tasks and use the debugging 
tools (LogWin and Database Spy), but they shut down automatically after running for 
two hours continuously. You can restart the Demo Mode again and run for another 
two hours, and so on.  

You cannot create or modify screens, worksheets, or project settings in Demo Mode.  

 Licensed for Engineering Only  
Enables all development options for an unlimited time.  

This mode also allows you to continuously run the runtime tasks and debugging tools 
(Database Spy, Output window, and LogWin module) for 72 hours. After that period, 
these tasks shut down, but you can restart them and run for another 72 hours, and so 
on. You can use this license for development and testing only.  

 Licensed for Runtime Only  
Enables all runtime tasks and debugging tools (Database Spy, Output window, and 
LogWin module) for unlimited time, but you cannot create or modify screens and/or 
worksheets.  

The menu options available in Runtime Only mode are the same as the options listed 
for Demo Mode (see previous table).  

 Licensed for Engineering + Runtime  
Enables all development options, runtime tasks, and debugging tools (Database Spy, 
Output window, and LogWin module) for an unlimited time. 
 
 

 License Activation 

 Softkey License 

1. Close InTouch Edge HMI (make sure that the process “Studio 
Manager.exe” is not running) 

2. Run the “Register” module (Windows button > “Register”) 
3. Select “Softkey > Check > Change License” 
4. Copy the “Hardware Identifier” 
5. Open the Link:- https://fs-

ext.invensys.com/adfs/ls/?wa=wsignin1.0&wtrealm=https%3a%2f%2fsoftwareOM.
wonderware.com%2f&wctx=rm%3d0%26id%3dpassive%26ru%3d%252f%253fstr%2
53dhttps%253a%252f%252fsoftwareom.wonderware.com%252fLicensegen%252fde
fault.aspx&wct=2019-05-15T10%3a41%3a48Z 

6. And get the activation code and authorize it. 
 
 

 

https://fs-ext.invensys.com/adfs/ls/?wa=wsignin1.0&wtrealm=https%3a%2f%2fsoftwareOM.wonderware.com%2f&wctx=rm%3d0%26id%3dpassive%26ru%3d%252f%253fstr%253dhttps%253a%252f%252fsoftwareom.wonderware.com%252fLicensegen%252fdefault.aspx&wct=2019-05-15T10%3a41%3a48Z
https://fs-ext.invensys.com/adfs/ls/?wa=wsignin1.0&wtrealm=https%3a%2f%2fsoftwareOM.wonderware.com%2f&wctx=rm%3d0%26id%3dpassive%26ru%3d%252f%253fstr%253dhttps%253a%252f%252fsoftwareom.wonderware.com%252fLicensegen%252fdefault.aspx&wct=2019-05-15T10%3a41%3a48Z
https://fs-ext.invensys.com/adfs/ls/?wa=wsignin1.0&wtrealm=https%3a%2f%2fsoftwareOM.wonderware.com%2f&wctx=rm%3d0%26id%3dpassive%26ru%3d%252f%253fstr%253dhttps%253a%252f%252fsoftwareom.wonderware.com%252fLicensegen%252fdefault.aspx&wct=2019-05-15T10%3a41%3a48Z
https://fs-ext.invensys.com/adfs/ls/?wa=wsignin1.0&wtrealm=https%3a%2f%2fsoftwareOM.wonderware.com%2f&wctx=rm%3d0%26id%3dpassive%26ru%3d%252f%253fstr%253dhttps%253a%252f%252fsoftwareom.wonderware.com%252fLicensegen%252fdefault.aspx&wct=2019-05-15T10%3a41%3a48Z
https://fs-ext.invensys.com/adfs/ls/?wa=wsignin1.0&wtrealm=https%3a%2f%2fsoftwareOM.wonderware.com%2f&wctx=rm%3d0%26id%3dpassive%26ru%3d%252f%253fstr%253dhttps%253a%252f%252fsoftwareom.wonderware.com%252fLicensegen%252fdefault.aspx&wct=2019-05-15T10%3a41%3a48Z
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 Hardkey License 

1. Close InTouch Edge HMI (make sure that the process “Studio 
Manager.exe” is not running) 

2. Run the “Register” module (Windows button > “Register”) 
3. Select “Hardkey > Check > Change License” . If you have a valid 

hardkey license installed — that is, if a valid USB hardkey is 
connected to the computer — the Hardkey Settings dialog box is 
displayed with the settings on that hardkey. 

 
4. Click Change License. The Change License dialog box is 

displayed with a unique hardware identifier that is generated from 
the USB hardkey itself. 

5. Open the Link:- https://fs-
ext.invensys.com/adfs/ls/?wa=wsignin1.0&wtrealm=https%3a%2f%2fsoftwareOM.
wonderware.com%2f&wctx=rm%3d0%26id%3dpassive%26ru%3d%252f%253fstr%2
53dhttps%253a%252f%252fsoftwareom.wonderware.com%252fLicensegen%252fde
fault.aspx&wct=2019-05-15T10%3a41%3a48Z 

6. And get the activation code and authorize it. 
 

 

https://fs-ext.invensys.com/adfs/ls/?wa=wsignin1.0&wtrealm=https%3a%2f%2fsoftwareOM.wonderware.com%2f&wctx=rm%3d0%26id%3dpassive%26ru%3d%252f%253fstr%253dhttps%253a%252f%252fsoftwareom.wonderware.com%252fLicensegen%252fdefault.aspx&wct=2019-05-15T10%3a41%3a48Z
https://fs-ext.invensys.com/adfs/ls/?wa=wsignin1.0&wtrealm=https%3a%2f%2fsoftwareOM.wonderware.com%2f&wctx=rm%3d0%26id%3dpassive%26ru%3d%252f%253fstr%253dhttps%253a%252f%252fsoftwareom.wonderware.com%252fLicensegen%252fdefault.aspx&wct=2019-05-15T10%3a41%3a48Z
https://fs-ext.invensys.com/adfs/ls/?wa=wsignin1.0&wtrealm=https%3a%2f%2fsoftwareOM.wonderware.com%2f&wctx=rm%3d0%26id%3dpassive%26ru%3d%252f%253fstr%253dhttps%253a%252f%252fsoftwareom.wonderware.com%252fLicensegen%252fdefault.aspx&wct=2019-05-15T10%3a41%3a48Z
https://fs-ext.invensys.com/adfs/ls/?wa=wsignin1.0&wtrealm=https%3a%2f%2fsoftwareOM.wonderware.com%2f&wctx=rm%3d0%26id%3dpassive%26ru%3d%252f%253fstr%253dhttps%253a%252f%252fsoftwareom.wonderware.com%252fLicensegen%252fdefault.aspx&wct=2019-05-15T10%3a41%3a48Z
https://fs-ext.invensys.com/adfs/ls/?wa=wsignin1.0&wtrealm=https%3a%2f%2fsoftwareOM.wonderware.com%2f&wctx=rm%3d0%26id%3dpassive%26ru%3d%252f%253fstr%253dhttps%253a%252f%252fsoftwareom.wonderware.com%252fLicensegen%252fdefault.aspx&wct=2019-05-15T10%3a41%3a48Z
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3. Getting Started 

3.1 The Development Environment 

 

3.1.1 Application button 

 The Application button opens a menu of standard Windows application commands like New, 

 Open, Save, Print, and Close.  

 Recent Projects: The Recent Projects area of the Application menu lists the most 
recently opened projects.  
 New: The New command on the Application menu is used to create a new 
worksheet file or project.  
 Open Project: The Open Project command on the Application menu is used to open 
a saved project.  
 Open: The Open command on the Application menu is used to open a saved 
worksheet file.  
 Save: The Save command on the Application menu is used to save the active screen 
or worksheet.  
 Save As: The Save As command on the Application menu is used to open a save the 
active screen or worksheet at another location.  
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 Save as HTML: The Save as HTML command on the Application menu is used to save 
the active screen in HTML format.  
 Save Screen Group as HMTL: The Save Screen Group as HTML command on the 
Application menu is used to save a selected screen group in HTML format.  
 Print: The Print command on the Application menu is used to print the active screen 
or worksheet.  

3.1.2 Quick Access  

1. Click Customize Quick Access Toolbar.  

2. In the list, click More Commands. The Customize dialog is displayed.  

 

3. In the Choose commands from menu, select the appropriate Ribbon tab. The 

commands from that tab are displayed in the Commands list.  

4. In the Commands list, select the command that you want to add to the Quick Access 

Toolbar.  

5. Click Add.  
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3.1.3 Ribbon 

 Home tab: The Home tab of the ribbon is used to manage your project within the 
 development environment.  
 View tab: The View tab of the ribbon is used to customize the look of the 
 development environment itself.  
 Insert tab: The Insert tab of the ribbon is used to insert new tags, screens, 
 worksheets, and other components into your project.  
 Project tab: The Project tab of the ribbon is used to configure your project settings.  
 Graphics tab: The Graphics tab of the ribbon is used to draw project screens.  
 Format tab: The Format tab of the ribbon is used to format and arrange objects in a 
 project screen.  
 Help tab: The Help tab of the ribbon provides additional help with using the 
 software.  

3.1.4 Project Explorer 

 Global tab: The Global tab of the Project Explorer contains the project tags 
 database, as well as other features that apply to the entire project such as the 
 security system, VBScript procedures, and UI translation.  
 Graphics tab: The Graphics tab of the Project Explorer contains all of the screens, 
 screen groups, and symbols in your project.  
 Tasks tab: The Tasks tab of the Project Explorer organizes the worksheets that are 
 processed as background tasks (i.e., server-based maintenance tasks that are not 
 directly related to screen operations or device I/O) during project runtime.  
 Comm tab: The Comm tab of the Project Explorer organizes the worksheets that 
 control communication with remote devices, using either direct communication 
 drivers or other common protocols.  

3.1.5 Screen/Worksheet Editor 

Screen editor features include:  

 Simple point-and-click, drag-and-drop interface  

 Grouping objects to preserve the construction steps of individual objects  

 Editing objects without having to ungroup internal object components or 

 groups  

 Handling bitmap objects and background bitmaps  

 Status line support in project windows and dialogs  

3.1.6 Database Spy 

 The Database Spy window is a debugging tool that allows you to monitor and 

force values to project tags; execute and test functions; and execute and test math 
expressions. The window contains the following elements: 

 For each item that you want to monitor during runtime:  

 Tag/Expression: Specify a project tag, system tag, or expression that 

 you want to monitor.  

 Value: Displays the value returned by the tag/expression.  
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 Quality: Displays the quality (GOOD or BAD) of the value returned by 

 the tag/expression.  

 Continuous: Select this option to have the project continuously 

 evaluate the tag/expression.  

 DB tabs: The windows is divided into multiple sheets, so that you can keep 

 your items organized.  

 Scroll bars: Use to view areas of the Database Spy that are obscured from 

 view because of the window size or the size of the current sheet.  

3.1.7 About the Output window  

 Use the Output window to view additional information about your project. By  default, the 

window is located in the bottom-right corner of the project development environment.  

 The Log tab displays the log messages that are generated by your project. You can 
 select exactly which types of messages are displayed, but generally speaking, the log 
 includes run-time messages from the tags database, the communication drivers, the 
 background tasks, the project security system, and so on, as well as certain 
 "housekeeping" messages generated by the project development environment 
 itself. You can use these messages to test and debug your project.  
 The XRef tab displays the results of using the Cross Reference tool to find where a 
 specific tag is used in your project. The results include the file path and name of the 
 worksheet in which the tag is used, as well as the column and row in the worksheet. 
 So, if something changes in the tag and produces unexpected or unsuccessful 
 results, you can locate all instances of the tag for debugging purposes. 
 The Find Results tab displays the results of using the Global Find command. 

3.1.8 Title Bar 

 The Title Bar located along the top of the development environment displays the 

 application name (e.g., InTouch Edge HMI) followed by the name of the active 

 screen or worksheet (if any).  

3.1.9 Status Bar 

 The Status Bar located along the bottom of the development environment 

provides  information about the active screen (if any) and the state of the 

application. 

 Execution Mode: The current execution mode of the application. 
 CAP: Indicates whether the keyboard Caps Lock is on (black) or off (grey). 
 NUM: Indicates whether the keyboard Num Lock is on (black) or off (grey). 
 SCRL: Indicates whether the keyboard Scroll Lock is on (black) or off (grey). 
 Object ID: The ID number of a selected screen object. 
 Cursor Position: The location of the cursor on the active screen or worksheet. 
 Object Size: The size (in pixels) of a selected screen object, where W is the width and 
 H is the height. 
 No DRAG: Indicates whether dragging is disabled (No DRAG) or enabled (empty) in 
 the active screen. 
 Tag Count: The total number of tags used so far in the project. 
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3.2 Tags and the Project Database 

3.2.1 Tags 

1. To create a new tag, right-click on the Project Tags folder, the Tag List sub-

folder, or Datasheet View icon and select Insert Tag from the shortcut menu. 

You also can click Tag on the Insert tab of the ribbon.  
2. The New Tag dialog displays, as shown in the following figure: 

 
3. Use this dialog to specify the following parameters:  

 Name field: Type a name for the new tag. The first character must be a letter and 
 you can use up to 255 characters in the name. (The tag name should be unique and 
 you cannot include ` ~! @ # $ % ^ & * ( ) - = \ + \ [ ] { } < > ? Symbols.) 
 Array Size field: Type a value to specify the size of the tag. Any size greater than 0 
 implies that the tag is an array. (Tag Syntax : ArrayTagName[ArrayIndex]) 
 Type combo-box: Select a standard tag type from the list (Boolean, Integer, Real, or 
 String). You also can define new types as structures formed by the classes.  

 Boolean (one bit): Simple boolean with the possible values of 0 (false)  
  and 1 (true).  

 Integer (four bytes): Integer number (positive, negative, or zero)  
  internally stored as a signed 32-bit 

 Real (floating point, eight bytes): Real number that is stored internally  
  as a signed 64-bit.  

 String (alphanumeric data, up to 1024 characters): Character string  
  up to 1024 characters that holds letters, numbers, or special   
  characters. Supports both ASCII and UNICODE characters.  

 Description text box: Type a tag description for documentation purposes.  
 Scope combo-box: Click to select one of the following options:  

 Server (default): The tag is maintained on the project server, and it is shared 
 by all connected thin clients. A change to the tag value affects the entire 
 project.  
 Local: A virtual copy of the tag is maintained separately on each local station 
 (server + clients), and a change to the tag value affects only the station on 
 which the change was made.  



 

  

SSM INFOTECH SOLUTIONS PVT. LTD. 13 

 

INTOUCH MACHINE EDITION BASIC LEARNING 

3.2.2 Project Database 

1. Select the Global tab and open the Project Tags folder.  
2. Double-click the Datasheet View icon to open the Project Tags datasheet: 

 
3. Locate an empty line in the datasheet and configure the following fields.  

 Name field: Type a name using the proper syntax. 
 Array Size field:  

 For an array tag, type a value to specify the maximum index of the array.  
 For any other tag type, type zero (0).  

 Type combo-box: Click the arrow to select a tag data type (Boolean, Integer, Real, or 
String) from the list.  

 Description field (optional): Type a description for documentation purposes only.  
 Scope combo-box: Click the arrow to specify whether the tag value will be shared 

with (displayed on) Thin Client stations.  
4. Click in a new line to create another tag, or if you have no other tags to create, then save 

and close the Project Tags datasheet.  

3.3 Download to an Industrial Computer 

3.3.1 Install Thin Client  

To install the InTouch Machine Edition Thin Client software:  

1. Locate the InTouch Machine Edition Client software installer in your InTouch Machine 
edition program folder. It is located at:  

C:\Program Files (x86)\Wonderware\InTouch Machine Edition 
v8.1\Redist\WebAddOn\ThinClient\ThinClientSetup.exe 

2. Copy the InTouch Machine Edition Thin Client software installer to the computer or device 
on which you want to install the software.  

3. On that computer or device, run the InTouch Machine Edition Thin Client software installer 
(ThinClientSetup.exe). The first page of the installation wizard is displayed.  

4. Click Next. The next page of the wizard is displayed.  
5. On the Customer Information page, type your name and your company name, and then click 

Next. The next page of the wizard is displayed.  
6. On the Choose Destination Location page, select the folder where the software should be 

installed, and then click Next. By default, the software will be installed at:  

C:\Program Files (x86)\Wonderware\InTouch Machine Edition Thin Client v8.1\<ID string>\ 

The next page of the wizard is displayed.  
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7. On the Select Features page, select the specific features and components that you want to 
install, and then click next.  

8. The next page of the wizard is displayed.  
9. On the Ready to Install the Program page, click Install. The software is installed, and then 

when the installation is finished, the last page of the wizard is displayed.  
10. Click Finish to close the installation wizard. 

3.3.2 Download project 

1. Turn on the target device, and then make sure your development workstation can 

connect to the device using either serial or Ethernet communication.  

2. Run Remote Agent, or restart the device so that it runs automatically. The remote 

Agent window is displayed. 

  

3. the communication settings in Remote Agent:  

 Click Setup. The Setup dialog box is displayed. 

 
 Select the appropriate connection type: Serial Port or TCP/IP. If you select 

Serial Port, also select the COM port and review the advanced settings. If you 

are already connected to the target device via ActiveSync, you do not need to 

select another connection at this time. However, keep in mind how the target 

device will actually be used during project run time.  
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 Click OK.  

 If you selected TCP/IP for the connection type, note the device's IP address.  

 Make sure that you leave Remote Agent running on the target device.  

4. the Remote Management tool to connect to the target device: 

 Run the project development application on your computer.  

 On the Home tab of the ribbon, in the Remote Management group, click 

Connect. The Remote Management dialog box is displayed. 

 
 Select the appropriate connection type for the target device: Host, Serial Port, 

or Microsoft ActiveSync. If you select Host, also type the host name or IP 

address of the target device. If you select Serial Port, also select the COM port 

and verify the advanced serial communication settings.  

 Click Connect. 

5. Go to Project tab and define the target location of the application file.  

 

 Select the download button to download the Files on target machine. 

 Select Run or Stop According to the requirement. 
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4. Communicating With External Devices 

4.1 Communication Drivers 

 You can configure the communication driver by following methods: 
o On the Insert tab of the ribbon, in the Communication group, click  Add/Remove 

Driver; or  
o Right-click the Drivers folder in the Project Explorer, and then click  Add/Remove 

drivers on the shortcut menu.  

 Use the parameters on this dialog, as follows:  
o Available Drivers field: Lists all available drivers and a brief description of  each.  
o Help button: Click to open the Help menu, which contains detailed  configuration 

instructions for the driver currently highlighted in the Available Drivers field.  
o Select button: Click to select the driver currently highlighted in the Available Drivers 

field.  
o Selected Drivers field: Lists all selected drivers and their descriptions (if available).  
o Remove button: Click to remove a driver currently highlighted in the Selected Drivers 

field.  

 When you click OK in the Communications Driver dialog, you create a subfolder for the 
selected driver(s) in the Drivers folder located on the Comm tab.  

 To find supported protocols, Refer the below link: 

http://blog.wonderware.com/2015/12/machine-edition-list-of-plc-drivers.html 

4.2 OPC DA 

 To Create a OPC connection to the end device: 
 Insert a new sheet in Comm tab OPC XML/DA> connections.

 
 Connection name: Define the name for the OPC connection. 

 Specification: select the specific OPC specification that is used by the OPC Server. 

 Host name: Server name or the IP address form where data to be fetched. 

 Server URL: Browse Server URL.(If it is not showing check DCOM settings) 

 User name: Define the user name of the connection to opc server. 

http://blog.wonderware.com/2015/12/machine-edition-list-of-plc-drivers.html
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 Password: Give the Password for that username of opc server. 

 parameters in the configuration table for OPC: 

 

 Description text box: Type a description of the OPC task for documentation.  

 Connection: Select the Connection Defined in connections. 

 Status: Define the tag to check the status of connection. 

 Status Message: Define the message that should be displayed in status. 

 Publish Rate (ms): type the frequency (in milliseconds) at which the client will 

request updates from the server. 

 Percent Deadband: only applies to server items that have the Engineering Units Type 

attribute (dwEUType) set to Analog (1). 

 Root node: specify the server node that will serve as the root for all items in the 

worksheet body. 

 Tag Name: Type the names of tags linked to the server items.  

 Browse Path: for DA, type <item name>; or for XML, type <item path>//<item 

name>. To browse the server's list of items, right-click in this field, and then on the 

shortcut menu, click Browse. 

4.3 Tag Integration 

 On the Insert tab of the ribbon, in the Communication group, click 

 Add/Remove Driver. 

 Add Driver which is supportable to your PLC.(Taking example of MOTCP) 

 Right click on MOTCP and insert a new sheet. 

 Configure the driver sheet. 

 Give a Description from documentation. 

 Enable read and write based on the requirement. 

 Header field: Specify the address of the first register of a block of registers on 

the target device. 

 Station field: Specify the IP Address of the device and the slot number, using 

the following syntax:<IP address>:<port number>:<PLC ID> 

 Define the header and address.(For help right click on driver folder and Select 

help.) 
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00001=> Header= 0x:1 Address=0  

30010=> Header= 3x:0 Address=10  

40001=> Header= 4x:1 Address=10 

 

 

4.4 Monitoring and Troubleshooting 

 Write a tag name in Database spy to monitor. 

o Good: Communication Successful. 

o Bad: Have any error in communication. 

 For Trouble shooting enable the setting of output window of Field read command, Field 

Write command and Protocol analyser. 

 For example if driver sheet is unable to get the data from plc end. 
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 When Driver sheet reads the data from PLC. 
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5.  Screens and Graphics 
5.1 Screens and Screen Groups 

1. To creat the new screen right click on screen option and go to insert then screen 

atributes popup is open. 

 

2. here write description about screen and here we can select different properties of 

the screen, and click ok. 

 

3. To save this screen right click on screen name and go to save, the name which we 

write here is the screen name. 
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4. To make screen group right click on screen group option one popup is open in which 
write screen group name and select screen which we want to add in group. 
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5.2 Shapes 

 In Graphics tab of the ribbon Shapes tool box is available which use for drawing static 
lines and shapes. 

 

5.3 Formatting 

1. When you select any object on the screen the formatting tool is visible. 

 

2. Here use of different arrange tools are as below; 

Bring to front: Bring selected object to front of drawing. 

Send to back: Bring selected object to back of drawing. 

Group: Make group of selected objects so they can be treated like single object. 

Align: Use for put selected object in same alignment. 

Rotate: Rotate the selected object. 

3. Position tool is use for set perfect x and y position of selected object. 

4. Size tool is use for resizing the selected object here we can also change width and height 

separately. 

5. Style tool is use for formatting the object, lines. 

6. Font’s tool is use formatting the tax lines. 

5.4 Active Objects 

 In Graphics tab of the ribbon the Active Objects toolbar provides the following tools, which 
you can use to create interactive objects. 
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I. Text object 

 On the Graphics tab, in the Active Objects group, click Text to create text objects, as 
follows  

 Click in the drawing area. When a cursor displays, you can type a line of text.  

 After entering the text string, double-click on the new text object to view the Object 
Properties dialog 

 
Use the Object Properties dialog to specify the following properties:  

 Caption: Specify a text string by typing a caption in the text box.  
 Text data link button: Click to apply the Text Data Link animation to the Text object.  

If the caption doesn't include any placeholder characters (###) for the text-data link, 
then clicking this button also automatically appends those characters.  

 Align: Align the text by selecting Left, Centre, or Right from the combo-box.  
 Fonts: Specify a font style for the text by clicking the Fonts button. When the Fonts 

dialog displays, you can specify the following parameters:  
o Font (typeface)  
o Font style  
o Size  
o Effects  
o Colour  
o Script  

 Border: Specify a text border by clicking the Border box.  
To select a border color, click the Color rectangle. When the Color dialog displays, 
click a color to select it, then close the dialog.  

 Background: Specify a background color by clicking the Color button. When the Color 
dialog displays, click a color to select it, then close the dialog.  

 Enable translation (optional): Specify an external translation file for the text by 
clicking (checking) this box.  
 

II. Text Box object 

 To draw and configure a Text Box object. 
 Open a screen for editing.  

mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Machine%20Edition%20v8.1/Bin/TechRef.chm::/references/r_dialog_objectproperties_textdatalink.html
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 On the Graphics tab of the ribbon, in the Active Objects group, click Text Box. The 
mouse cursor changes to a crosshair for drawing.  

 Draw the object where you want it on the screen, and then further move or resize it 
if necessary.  

 Double-click the object. The Object Properties dialog box is displayed.  
 

 

 In the Hint box, type a hint or tooltip that you want to have displayed during run 
time when the mouse hovers over the object.  

 In the Tag/Expression box, type the name of a project tag or an expression to 
associate it with the object.  

 In the Format list, select how the numerical value (if any) of the specified 
tag/expression will be formatted and displayed on-screen. Available options include 
Decimal, Hexadecimal, Binary and Auto. 

 By default, Input Enabled is selected. If you do not want to allow user input during 
run time, clear this check box. 

 In the Mask/Count box, type a value that will restrict the input:  
To mask a numerical value so that it matches a specific format, type one or more # 
characters. Each # represents one character of input/output. You may include a 
decimal separator for decimal values (e.g., ###.##). 

 In the Minimum Value and Maximum Value fields, type the minimum and maximum 
numerical values (if any) that will be accepted from the user. 

 In the Disable box, type the name of project tag or an expression. This is optional. 
When the value of the tag/expression is TRUE (1), the object is disabled. 

 To make the object accept/display multiple lines of text, select Multi-line . When 
Multi-line is selected, the Scroll Bar and Word Wrap options also become available 
and the Password option becomes unavailable.  

 To make the object obfuscate text input (e.g., ********), select Password.  

III. Button object 
 The Button object 
 On the Graphics tab, in the Active Objects group, click Button to create custom-sized 

buttons, as follows:  
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 Click in the drawing area and drag the mouse/cursor to create the button shape.  
 Release the mouse button when the button is the size you want.  
 Double-click on the object to view the Object Properties dialog. 

 
 

 Use the Object Properties dialog to specify the following parameters for the button:  
 Caption: Specify a caption by typing the text into the text box. You can include a tag by 

enclosing it in curly brackets (e.g., {tagname}).  
 Style: Select a style for the button. 
 Fonts: Specify a font style for the caption by clicking the Fonts. 
 Images: Insert an image file into the button by clicking the Images button. 
 Advanced: Specify advanced settings for the button by clicking the Advanced button. 
 Command: Click to automatically apply a Command animation to the button and then switch 

to the animation's properties. 
 

IV. Pushbutton object 
 

 To add one or more pre-configured buttons to a screen:  
 Click the Pushbutton tool, and position the mouse (pointer) on the screen.  
 Click and drag to create/adjust the size of the rectangular button.  
 Double-click on the object to open the Object Properties dialog.  

 

 

 Type drop-down list: Click to select the pushbutton type (Momentary (default), 

Maintained, or Latched).  

 State drop-down list: Click to specify a default state for the pushbutton (Normally 

Open (default) or Normally Closed).  

 Tag/Exp text box: Type a tag or an expression to accomplish the following:  

o Type in a tag to receive the Write Value from the appropriate state (Open or 

Closed) area in the Configuration dialog.  

mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Machine%20Edition%20v8.1/Bin/TechRef.chm::/references/r_dialog_objectproperties_command.html
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o Type an expression to execute On Down, when you press the pushbutton 

down.  

 Indicator text box: Type a tag to define an indicator that causes the button to change 
to a specified color when the tag value matches one of two specified values. If you 
leave this field blank, the indicator changes color automatically when you press the 
button. 

 E-Sign checkbox: When this option is checked, the user will be prompted to enter the 
Electronic Signature before executing the animation.  

 Reset text box (active for Latched pushbutton type only): Type a tag to control the 
button's latched state, as follows:  

o Type a zero and the button will remain in a latched state after you press it.  
o Type a nonzero value and a latched button will become unlatched after you 

press it. You must reset the tag value to zero before you can press the button 
again.  

 Key area: Specify a keyboard key or create a key combination to toggle a pushbutton 
when you have no pointing device (mouse or touch screen) or if you want to create 
shortcut keys in addition to pushbuttons.  

 Key drop-down list: Type a key in the text box or select a non-alphanumeric key from 
the drop-down list. Enter a single character or key only. Numbers are not valid 
entries for this field. 

V. Check Box object 

 On the Graphics tab, in the Active Objects group, click Check Box to create a Check Box 
object on your screen:  

 Double-click on the object to view the Object Properties dialog.  

 
 Use the Object Properties dialog to specify the following parameters for the Check Box 

object:  
 Caption: Specify a caption by typing the text into the text box. You can include a tag by 

enclosing it in curly brackets (e.g., {tagname}).  
 Confirm check box: Click (check) this box to ensure ITME prompts you to confirm the action 

at runtime. 

 Security field: Type a value in this field to specify a security level for the object, as 

defined under Security. When a user logs on, and does not have the specified security 

level, ITME disables the object.  

 Tag field: When the user clicks on the check box during runtime, the value of this tag 

is updated. If no Feedback was specified, the value of this tag is also used to indicate 

the current status of the object.  
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 True Value field: Specify a value that will be used to change the control to TRUE 

state and to indicate that the control is in TRUE state. For more information about 

states, please refer to the states table. 

VI. Radio Button object 
 On the Graphics tab, in the Active Objects group, click Radio Button to create a radio button 

object on your screen. 

 Double-click on the object to view the Object Properties dialog. 

 

 Here, Object Properties are same as check box object. 

VII. Combo Box object 
 

 On the Graphics tab, in the Active Objects group, click Combo Box to select a single label 
from a combo-box list of labels. 

 Double-click on the combo-box object to open the Object Properties dialog box. 

 
 Label text box: Type a string tag to receive the value of the label currently displayed in the 

combo box.  

 Position text box: Type an integer tag, which corresponds to the label currently displayed in 
the combo box. Changing this tag value changes the label being displayed.  

 Disable text box: Type a tag with a nonzero value to disable this combo box. Type a zero, or 
leave the field blank (default) to enable the Command animation.  
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 Advanced button: In this we can specify the number of items that should be displayed at 
one time when the user clicks on the combo box, and also specify the label alignment. 

 Data Sources button: Use the Data Sources dialog box to configure the items/labels that will 
be displayed in the Combo Box object, here total four data source type we can select. 

o Static Labels Data Source Type: In this go to setting and Enter your labels — with one 
label per line — just as if you were editing a plain text file. 

o Array Tag Data Source Type: Enter the name of a String array that contains the items 
for the combo box, specify how much of the array should be displayed in the combo 
box. Keeping in mind that the combo box counts array index 0 as the first item, if 
you enter a value of 4, then the combo box will display array index 0 through array 
index 3. 

o Text File Data Source Type:  Enter the name of the text file source. You can either 
type the file name and its path or click the … button to browse for it. 

 Sort checkbox: Click (check) to display the contents of your array of labels in 

alphabetical order. This parameter is available only when you select the Array Tag 

type.  

 

VIII. List Box object 
 On the Graphics tab of the ribbon, in the Active Objects group, click List Box.  
 Double-click on the object to open the Object Properties dialog.  

 

 Value drop-down list (located below the Replace button): Click to select one of the 

following the tag values used to index the message list.  

o Boolean  

o Integer (default)  

o LSB (Least Significant Bit)  
 Messages button: Click to open the Messages Configuration dialog 



 

  

SSM INFOTECH SOLUTIONS PVT. LTD. 29 

 

INTOUCH MACHINE EDITION BASIC LEARNING 

 

 User Enable text box: Type a tag, expression, or a (nonzero) number to select a 

message in the runtime project. The default is 1 (true or enabled).  

 Control Enable text box: Type a tag, expression, or a (nonzero) number to select a 

message in the runtime project — depending on the current value of the Read/Search 

Tag. The default is 1 (true or enabled).  

 Read/Search Tag text box: Type an integer or a Boolean tag to point to a selected 

message based on the message Value field (in the Messages Configuration dialog). 

You can use the Control Enable and User Enable fields to control whether the 

operator or a process can alter this tag.  

 Write Tag text box (optional): Type a string tag to receive the Message value of the 

last-selected message. When you close and reopen the screen containing a List Box 

object, ITEH uses this tag value to determine the last message selected in the list box.  

 Row checkbox: Click (check) to include set up and set down arrows in the List Box 

object scroll bar.  

 Page checkbox: Click (check) to include page up and page down arrows in the List 

Box object scroll bar.  

 Start/End checkbox: Click (check) to include home and end arrows in the List Box 

object scroll bar.  

 List wrap checkbox: Click (check) to continue displaying and scrolling the message 

list (starting at the opposite end) after you scroll to the beginning or end of the list 

IX. Smart Message object 
 

 On the Graphics tab of the ribbon, in the Active Objects group, click Smart Message.  
 Double-click on the object to open the Object Properties dialog.  
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 Type combo-box: Click to select the smart message object type. The object type sets 

the behavior of the object during run time and the features supported by it:  

o Message Display (default)  

o Multistate Indicator  

o Multistate Pushbutton  

 Value type drop-down list: Select the type of values used to index the message list:  

o Boolean: Provides two valid states. Use this selection when you want to display 

either one of two different messages, based on a Boolean value (0 or 1).  

o Integer (default): Provides 500 valid states.  

o LSB (least significant bit): Provides 32 valid states (i.e., 32 bits in an integer 

value). 

 Switch event drop-down list (available for Multistate Pushbutton only): Select one of 

the following options to specify when the message is changed:  

o On Down: Switch to the next message when you click on the object (default).  

o While Down: Switch to the next message continuously while you hold the 

mouse button down on the object.  

o On Up: Switch to the next message when you release the mouse button on the 

object.  

 Check expression on each message line check box: When this option is cleared, only 

Read Tag/Expression is evaluated during run time and the resulting value determines 

which message is displayed.  

 Read Tag/Expression text box: Enter a project tag or expression. The value determines 

which message is displayed by the object during run time.  

 Messages: Displays the Configuration dialog box, where you can configure the 

messages for the object. See "Messages Configuration" below. 
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5.5 Animations 

 Use the Animations group to apply animations to a screen object or group of objects 

 

I. Command animation 

  Firs select object and on the Graphics tab, in the Animations group, click Command to add 
the animation to a selected object or group of objects. Double-click on the object to view its 
object properties. 
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 The Command animation provides one tag for each one of the events supported by it. Notice 
that more than one event can be configured simultaneously for the same Command 
animation. 

 Type menu: This setting defines the type of action that must be executed by the event 

of the Command animation.  

Type Description 

Built-in Language Allows you to configure a script using the ITEH built-in 

language. When this type is selected, the user can configure up to 

12 expressions for each event in the Expression column.  

VBScript Allows you to configure a script using the standard VBScript 

language.  

Open Screen Allows you to configure the Command animation to open a 

specific screen when the event is triggered during runtime.  

 

Close Screen Allows you to configure the Command animation to close a 

specific screen when the event is triggered during runtime.  

Set Tag Allows you to configure the Command animation to set a tag 

when the event is triggered during runtime. 

Reset Tag Allows you to configure the Command animation to reset a tag 

when the event is triggered during runtime.  

Toggle Tag Allows you to configure the Command animation to toggle a tag 

when the event is triggered during runtime.  

 Config button: Launches the Configuration dialog, where the Command animation 

can be fully configured. 
 

 
 Here in run time we seen that when we click on Inc.Xval button value of Xval tag is increase 

by one. 
 

II. Hyperlink animation 
 

 On the Graphics tab, in the Animations group, click Hyperlink to add the animation to a 
selected object or group of objects. 
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 Double-click on the object to open the Object Properties dialog. 

 
 You can use this dialog to specify the following parameters: 
 Hyperlink Type combo-box: Click the combo-box button to select a URL protocol from the 

list.  
 URL field: Type the URL address you want to load. 
 Disable field: Type a value greater than zero into this field to disable the hyperlink Command 

animation for the selected object(s). 
 In run time when we click on this button Wonderware.com site is open. 

 

III. Bargraph animation 
 On the Graphics tab, in the Animations group, click Bargraph to add bar graph properties to 

a selected object, then double-click on the object to open the Object Properties dialog.  
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 Tag/Expression field: Type a tag or expression that evaluates the bar graph level. You also can 
click the icon to browse your directories for an existing tag or expression.  

 Minimum Value field: Type a numeric constant or a tag value into this field to define the 
minimum value used to calculate the height (if vertical) or width (if horizontal) of the bars.  

 Maximum Value field: Type a numeric constant or a tag value into this field to define the 
maximum value used to calculate the height (if vertical) or width (if horizontal) of the bars. 

 Foreground Color: To specify a fill color for the bars. 
 Direction area: Click the Vertical or Horizontal radio button to specify the direction of the bar 

graph.  
 Orientation area: Click the Up, Center, or Down radio button to specify the orientation of the 

maximum and minimum values when drawing the bars.  
 In run time when we change the slider value from 0 to 100 the vertical box is filling from down 

to up. 

IV. Color animation 
 On the Graphics tab, in the Animations group, click Color to add the animation to a selected 

object. 
 Double-click on the object to open the Object Properties dialog. 

 

 Type: Determines the mode in which this animation works:  
o By Limit: When selecting this type, you can specify up to four limits (Change Limit) 

for this animation and a color for each limit.  
o By Color: When selecting this type, you can specify the code of the color that must be 

 applied to the object directly in the Tag/Expr field. 
 Change Limit field: Type a limit value (a numeric constant or tag) for the color change. 
 Color combo box: Click the combo-box button to associate a color with each color change 

limit. 
 Blink combo-box: Click the combo-box button to specify whether the color change will blink, 

and how fast it will do so.  

V. Text Data Link animation 
On the Graphics tab, in the Animations group, click Text Data Link to add the animation 
input or output text property to a selected Text object. 
 

mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/references/r_dialog_objectproperties_text.html
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 Tag/Expression text field: Type one of the following into the field:  
o The name of a tag on which to perform an input or output operation; or  
o An expression on which to perform an output operation only. 

 Format combo-box: Click to select how the numeric value (if any) of the specified tag or 
expression will be formatted and displayed on-screen. Available options include Decimal, 
Hexa (i.e., hexadecimal), Binary and Auto. 

 Input Enabled checkbox: Click (check) this option to allow user input to the specified tag. 
Disable (uncheck) this option to only display the output from the specified tag or expression.  

 Back to text: Click to go back to the object properties of the underlying Text object. 
 Auto Size checkbox: Click (check) this option to automatically resize the Text object to fit the 

output. This option is not available if Input Enabled is checked. 
 

VI. Visibility/Position animation 
 On the Graphics tab, in the Animations group, click Visibility/Position to add the 

animation to an object.  

 

 



 

  

SSM INFOTECH SOLUTIONS PVT. LTD. 36 

 

INTOUCH MACHINE EDITION BASIC LEARNING 

 Visibility box: Configure a tag/expression in this box to control the visibility of the object. 
When the value of the tag/expression is 0 (FALSE), the object is hidden, and when the value 
is non-zero (TRUE) or the box is left empty, the object is visible. 

 Tag/Expression boxes: Configure a tag/expression that will determine the position of the 
object during run time. 

 Value range boxes: Enter the minimum and maximum values for the tag/expression. 

 Position boxes: Enter values to specify how far (in pixels) the object can move from its 
starting position. 

 Reference drop-down lists: Select a reference point on the object. This reference point is 
meaningful only if you have the Resize animation added to the same object. 

 Slider/Gestures: When multi-touch gestures are enabled, the end user can use one- or two-
finger "slide" gestures to move this object during run time. 

 

VII. Resize animation 

 The Resize animation allows you to increase or decrease the size of an object during 
runtime. 

 
 Tag/Expression boxes: Configure a tag/expression that will determine the size of the object 

during run time. 

 Size range (%) boxes: Enter the minimum and maximum values for the size of the object. The 

minimum value can be as low as 0% (making the object effectively invisible), and the 

maximum value can be as high as you want. 100% is the original size of the object when you 

draw it in the screen worksheet, 200% is double the original size, and so on. 

 

VIII. Rotation animation 

 On the Graphics tab, in the Animations group, click Rotation to add the animation to a Line, 
Open Polygon, Closed Polygon, Bitmap, or Linked Picture object. 

 After the animation is added, double-click the object to open the Object Properties dialog 
box.  
 

mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/references/r_dialog_objectproperties_resize.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/references/r_dialog_objectproperties_line.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/references/r_dialog_objectproperties_openpolygon.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/references/r_dialog_objectproperties_closedpolygon.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/topics/graphics_objects_bitmap.html#graphics_objects_bitmap_adding
mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/topics/graphics_objects_linkedpicture.html#graphics_objects_linkedpicture
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 Tag/Expression box: Specify a tag/expression that will determine the angle of the object 

during run time; as the value changes, the object is rotated in the screen. 
 Range area: Enter the Minimum and Maximum values allowed for Tag/Expression. 
 Rotation (degrees) area: Enter the Start and End positions (in degrees) of the object. 
 Reference combo-box: Select one of the following as a pivot point on which to rotate 

the object:  
o Left-Top: Upper-left corner of the object.  
o Left-Bottom: Lower-left corner of the object.  
o Center: Center of the object.  
o Right-Top: Upper-right corner of the object.  
o Right-Bottom: Lower-right corner of the object. 

 Advanced button: In this Enter the number of pixels by which to offset the Reference 
(i.e., pivot point) on the X axis and/or Y axis. 
 

5.6 The Symbol Library 

 The Symbols library is a visual browser for symbols all of that are available to be 

used in your project screens. To open the library: on the Graphics tab of the ribbon, in 

the Libraries group, click Symbols.  

 

mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/topics/Graphics_Tab_Symbols_Folder.html
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 The library is divided into two main folders: the Project Symbols folder contains your 
user-made symbols for the current project, and the System Symbols folder contains 
all of the premade symbols (sorted by type) that are installed with the InTouch Edge 
HMI software.  

 To select a symbol and place it in a project screen:  
o Find the symbol you want in the library, and then double-click it. The mouse 

cursor will change to indicate that you have a symbol waiting to be placed.  
o Return to the project screen where you want to place the symbol.  
o Click anywhere in the project screen to place the selected symbol.  
o Edit the symbol's object properties as needed, including any custom 

properties.  

5.7 Project Symbols 

 To create a master symbol and save it to the Symbols folder:  

 Design your symbol just as you would normally draw a project screen, using any combination 
of Static and Active Objects. 

 First make group of that symbol. 

 Then right click on that symbol and go to create link symbol. 
 

 
 

 A standard Save As dialog box is displayed, and you are prompted to give the new symbol a 
file name. Symbol files (*.sym) are saved in the \Symbol folder of your project.  

 Click Save to save the file. The symbol appears in the Project Symbols folder, in the Graphics 
tab of the Project Explorer and also appears in the Project Symbols folder of the Library. 

mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/topics/Graphics_Tab_Symbols_Folder.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/references/r_dialog_objectproperties.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/topics/ribbon_graphics_shapes.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/topics/ribbon_graphics_activeobjects.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/topics/projectexplorer_graphics.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/topics/projectexplorer_graphics.html
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 If you make any changes to the master symbol, those changes automatically propagate to 
every linked copy in every project. 

5.8 Project Localization 

 You can quickly translate your project's user interface to multiple languages 

 To add a target language to the Translation Table: 

 Open the Translation Table worksheet by doing one of the following:  
o On the Insert tab of the ribbon, in the Global group, click Translation. 

 
 Make sure the Enable Translation option is selected.  
 Set the source language:  right of the Source language box, click the browse button. 

The Languages dialog box is displayed.  
o In the Languages dialog box, select the language for which your project was 

originally developed, and then click OK. The selected language is set in the 
Source language box.  
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o Set the target language: In the Target languages group, click Add. The Languages 
dialog box is displayed.  

o In the Languages dialog box, select the language to which you want to 
translate your project, and then click OK.  

o The selected language is added to the Select list, and a new worksheet is 
created for the language.  

 Configure Date order and Date separator as needed for the target language.  

 Use the Filters to search the worksheet for specific text items. 

 For each text item in the Source column, enter the translation in the Target column. 
You can manually translate the items one by one, or you can use a translation service 
such as Google Translate to automatically translate multiple items.  

 Review the translated items in the Target column in order to confirm the translations 
and make sure they correspond with the untranslated items in the Source column. If 
you want to keep the original, untranslated text for a specific item, leave the Target 
column blank.  

 Save and close the worksheet.  
 Set the project's language during run time 

 In the Graphics tab of the Project Explorer, double-click a project screen to open it 
for editing.  

 On the Graphics tab of the ribbon, in the Active Objects group, click Button.  

 Draw a Button object in the project screen.  

 Double-click the Button object. The Object Properties dialog is displayed.  

 In the Caption box, type English.  

 Click Command. The Command animation properties are displayed in the dialog.  

 In the first row of the On Down tab, in the Expression field, type SetLanguage(1033).  

 

o Close the Object Properties dialog. 
o Duplicate the Button object, replacing the caption with French and the expression 

with SetLanguage(1036). 

 Save and close the project screen. 
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6. Scripting 

 Client-Side Scripts 

 There are total four type of scripting. 

 Runtime script 

 Right-click  the Scripts folder in the Project Explorer, and then click Insert on the 
shortcut menu 

 

 Here in description box write some description about script. 

 We write some condition in execution field, the code configured here is executed 
while the condition configured in the Execution field is TRUE, here we write 
second that means at every second this minute value is transfer to the tag b. 

 Here if in execution tab we write 1 that means script is continuously executing 
while running. 

  

 Start-up script 

 Open the start-up script in the script folder of project explorer. 

 
 The code configure here is execute one time when run time is start. 

 Here value of minute is transfer to the tag A at ones when run time is start. 
2. Procedure script 

 First insert one procedure script in global tab of project explorer. 
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 When we call this procedure script value of minute is transfer to tag d. 

 Now, take one button for call this procedure script. 

 
 

 Here when we push this button it call d_value script that is procedure script. 
3. Command script  

 Take on button and go to its command and write script for on down command, 
here we can write other scripts for other command also. 
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 When the button is pressed value of minute is pass to tag c. 

 In run time we can see result of all this four scripts. 
 

 
 

 We start run time at 22 min so tag A value is 22 , and we push both buttons at 23 
min so value in c and d tag is 23. 
 

 Background Tasks 

 Background tasks are, as the name implies, project features that run in the 
background, as opposed to the graphical screens with which the user interacts.  

 The background tasks are executed by the Background Tasks module, and they are 
defined by task worksheets in the Project Explorer.  

 The tasks shows in project explorer are all back ground tasks. 

 For changing stat of any task go to task function on local management box on home 
ribbon. 
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 Select the task in the list, and then click Startup on the right. The Startup dialog box 

is displayed. 

 Select manual or automatic as needed.  

 Click OK.  

 So if background tasks are not start on change its stat from here. 
 

7. Alarms and Events 

7.1 Alarms 

 To create a new Alarm worksheet, do one of the following: 
o On the Insert tab of the ribbon, in the Task Worksheets group, click 

Alarm;  
o Right-click the Alarms folder in the Project Explorer, and then click Insert 

on the shortcut menu; or  
o Click New on the Application menu, click the File tab, and then select 

Alarm Worksheet.  

 To edit an existing Alarm worksheet, double-click it in the Project Explorer. 
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The following table describes the Header settings on an Alarm worksheet: 

Field Remarks 

Description Description of the alarm group.  

Group Name Name of the Alarm group. 

Email Settings Launches the Email Settings dialog, where you can 
configure the settings for emails sent automatically based 
on alarm conditions.  

Advanced Launches the Advanced Settings dialog, where you can 
configure the settings for emails sent automatically based 
on alarm conditions.  

On Line 

> Display in Alarm Controls 

When checked, the alarms are available to be displayed on 
the Alarm/Event Control object.  

On Line > Ack Required When checked, the alarms require acknowledgment. 

On Line > Beep When checked, the computer keeps beeping while there are 
alarm(s) to be acknowledged, currently active. 

On Line > Send to printer Now, when this option is selected, alarm messages are 
simply passed to an external batch file as soon as the alarms 
are created.  

mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/references/r_worksheet_tasks_alarm.html
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Field Remarks 

History > Save to Disk When checked, the alarm messages are stored in the history 
log when they become active.  

History > Generate Ack Messages When checked, the alarm messages are stored in the history 
log when they are acknowledged.  

History 

> Generate Norm Messages 

When checked, the alarm messages are stored in the history 
log when they become normalized.  

Colors in Alarm Controls > Enable When checked, the alarms configured in this group will be 
displayed with the colors assigned to each alarm state. 

Colors in Alarm Controls 

> FG and BG 

You can configure the text foreground color (FG) and 
background color (BG) for the alarms displayed on the 
Alarms/Events Control object. 

 The following table describes the Body settings on an Alarm worksheet:  

Field Description 

Tag Name Name of the tag associated with the alarm. 

Type  Type of the alarm: 

 HiHi: Activates the alarm if the tag value is greater than or equal to the 
specified limit.  

 Hi: Activates the alarm if the tag value is greater than or equal to the 
specified limit. (For Boolean tags, if the value is 1.)  

 Lo: Activates the alarm if the tag value is less than or equal to the specified 
limit. (For Boolean tags, if the value is 0.)  

 LoLo: Activates the alarm if the tag value is less than or equal to the specified 
limit.  

 Rate: Activates the alarm if the tag value changes more than the specified 
limit in a given period. (For Boolean tags, if the value changes at all.)  

 DevP: Activates the alarm if the tag value is greater than or equal to the tag's 
deviation set point plus the limit.  

 DevM: Activates the alarm if the tag value is less than or equal to the tag's 
deviation set point minus the limit.  

Limit  Limit associated with each alarm. 

Message  Message associated to the alarm. 

Priority  Priority number associated to the alarm. 

mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/topics/alarms_historyformat.html#alarms_historyformat
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Field Description 

Selection  Alias associated to the alarm (e.g., AreaA, AreaB, etc). When displaying 
alarms on the Alarm/Event Control object, the operator can filter and/or sort 
the alarms by their selection value.  

Custom 

fields 

 Additional custom fields that will be saved in history. 

 In run time we can see that when value of sl2 is below the lolo limit the alarm is 

generate. 

 

7.2 Events 

 In the Project Explorer, on the Global tab, double-click Event Logger. The Event 
Settings dialog is displayed. 
 

 

 Select Enable event logger. 

 In the Disable box, type the name of a project tag. Whenever the value of the tag is 
TRUE (i.e., non-zero) during runtime, event logging will be suspended.  

 In the Settings area, select which types of events that you want to log to the history 
file.  

mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/references/r_dialog_objectproperties_alarmeventcontrol.html
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Option Description 

Security System Events generated by your project's security system, including:  
o Log On / Log Off users  
o User created/removed by calling the Create User or 

Remove User functions  
o User blocked/unblocked by calling the Block User or 

Unblock User functions  
o User blocked by the security system after several 

attempts to enter an invalid password  
o Password expired  
o Password modified  
o Invalid Log On attempt  

Display Open Screen and Close Screen events. 

Recipe Recipes loaded, saved, initialized, or deleted. 

Report Reports saved to disk or sent to printer. 

Custom Messages Events generated by calling the Send Event function.  

System Warning Various runtime warnings and errors, including:  
Errors that occur when sending alarms by email  
Tag was blocked/unblocked  
Division by zero  
Connection/Disconnection of the remote security system  

 

 To log changes in specific project tags, select Tags, and then in the table, specify the 
tags.  
 

Column Description 

Tag Name The name of the project tag that you want to log to the history file. 

Dead Band A value to filter changes against, so that only changes greater than 
this value are logged.  

Message A string (message) related to this tag change.  

 

 The Tags option is useful for logging events that are not important enough to be 
alarm conditions (for example, Motor On, Motor Off, and so on).  

 Click OK.  

 Now for view this events generation take one alarm/event control from graphic 
object. 

 And select event type in its properties dialog box. 

mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/topics/functions_security_createuser.html#functions_security_createuser
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 In run time we can see the event generated when we change value of sl2 tag. 
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8. Data Logging and Display 

8.1 Trend 

 Right-click the Trends folder in the Project Explorer, and then click Insert on the 
shortcut menu or  

 Click New on the Application menu, click the File tab, and then select Trend 
Worksheet.  

 To edit an existing Trend worksheet, double-click it in the Project Explorer. 

 
 

 Description: Type a description of the worksheet for documentation purposes.  
 History Format: Click the arrow button to select a trend history format from the list. 
 Save On Trigger: Click (enable) and type a tag name to save trend samples when 

someone changes the specified tag. (Tag change can be an event from the 
Scheduler.)  

 Save On Tag Change: Click (enable) to always save the trend sample when a value 
change occurs in any of the tags from that group. 

 Tag Name: The name of the project tag for which trend history will be saved.  
 Dead Band: Type a value to filter acceptable changes when Save on Tag Change is 

used.  
 To generate real time trend graph On the Insert tab of the ribbon, in the Task 

Worksheets group, click Trend. 
 Click on screen where you want the trend graph, then open its properties dialog box. 
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Trend Control dialog box contains the following elements:  

Area / Element Name Description 

Border Type Sets the type of border around the graph area of the trend control.  

Color Sets the color of the border, if the border type is Solid.  

Background No Fill / Fill Enables the background fill for the graph area of the trend control.   

Color Sets the color and fill effect of the background fill, if it is enabled.  

Points Opens the, which allows configuration of the trend control's data 

points (or pens).  

Axes Allows configuration of the trend control's X and Y axes, as well as its 

horizontal or vertical orientation.  

Toolbar Allows configuration of the user toolbar that is displayed above the 

trend control.  

Data Sources Allows configuration of multiple data sources for the trend.  

Legend Allows configuration of the legend that is displayed below the trend 

control.  

Advanced Allows configuration of the trend control's advanced properties, such 

as runtime options and tag triggers  
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 To add tags in this trend graph go to points of its properties and add tag which you 
want to show on graph. 

 
 

 Here we add sl2 tag. 
 So in run time we can see that the value of sl2 slider is display on graph. 

 

 
8.2 Grid Control 

 The Grid object allows you to read/write data in a tabular format from the data 
source configured in the object. 

 On the Graphics tab of the ribbon, in the Data Objects group, click Grid.  

 When double click on that its properties dialog box is open. 
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 Data Source: Select the data source type. 

 Data source settings: where you can specify a data source for the Grid object.  

 Columns: where you can configure the settings (such as label, column, width, etc.) 
for the columns of the Grid object.  

 Advanced: where you can configure several settings for the Grid object.  
 Highlight: Select a background color for the selected row, during runtime.  

 Text: Select a text color for the selected row, during runtime.  

 Odd lines: Select a background color for the odd rows.  

 Even lines: Select a background color for the even rows. 

 Here in data source setting we browse the csv file from where we want data. 
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 In run time we can see the data of csv file. 

 

 

9. Recipes and Reports 

 Recipes 

 Right-click the Recipes folder in the Project Explorer, and then click Insert on the 

shortcut menu. 

 A new Recipe worksheet is opened for editing in the Screen/Worksheet Editor 
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 In the Description box, type a description of the recipe. 

 In file name field enter the path where we want to save the report with file name. 

 In the Register Number box, type a tag to define the register number to be read from 

or written to a database file. 

 Select the Save as XML option to save the data to a standard .xml file. 

 Select the Unicode option to save the data in Unicode format. 

 In the Tag Name column, type the name of the project tag. 

 In the Number of Elements column, type the number of elements that you want to 

include from the specified tag. 

 Save and close the worksheet. 

 Now take screen and take buttons for recipe operation, operation of recipe must be 
one of the following:  

Operation Description 

Save Save tag values to the data file. 

Load Load tag values from the data file. 

Delete Delete the data file that is specified in the Recipe worksheet. 

Init Initialize the data file with value of 0 for all included tags. 

 For recipe load button 
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 For recipe save button 

 
 For recipe delete button. 
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 Now in run time when we enter the value of tags and click on save button the recipe 
is generated and save at the given path. 
 

 

 Check at given path and open the recipe. 

 
 Reports 

 Report is a built-in function that executes the specified Report worksheet and sends 
the output to hard disk, printer, or PDF.  
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 First Right-click the Report folder in the Project Explorer, and then click Insert on the 
shortcut menu. 

 
 

 Here we can make report in html, rtm, csv and txt form, here write HTML code for 
create HTML report. 

 In output file enter the path where we want to save the report with file name. 

 Then open screen and take one button and write script for report generation. 

 

 
 

 For different operation write different value as below. 
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Value Description 

Disk Save file to hard disk. 

Prn Send report to default printer. 

Pdf Generate a PDF file of the report. 

 Now in run time click on this button and check the report generated at given 
location. 
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10. Project Security 

10.1 Project Security 

10.1.1 Types of Project security 

 Local Only: This is the standard mode for most projects: users and groups are 
created in the project development environment, and they apply only to the project 
for which they are created.  

 Distributed – Server: This is similar to Local only, except that the project's security 
system configuration is also made available to other projects (that are set to 
Distributed – Client) on the same network. Furthermore, if the project loses its 
security system configuration for some reason, it can reimport the configuration 
from one of its client projects.  

 Distributed – Client: When this mode is selected, the project gets its entire security 
system configuration from another project (that is set to Distributed – Server) on the 
same network. The project caches this configuration and can continue to run even if 
it loses communication with the server project.  

 Domain (LDAP): The Lightweight Directory Access Protocol (LDAP) is a recognized 
standard for managing users and groups across many different applications on a 
network. When this mode is selected, the project gets its users and groups from an 
LDAP-compliant domain server 

10.1.2 Project security Configuration 

 Open the Project tab of the ribbon, in the Security System group, click Configure. 
 If you have already configured the security system for your project, open the Security 

System dialog box as described above and then click Run Wizard. 
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This page always shows how the security system is currently configured. 

 Click Next. 

 
 Select the Enable Security System option, if it is not already selected. The security system is 

enabled by default for new projects. And Set the Main Password for your project. (The Main 
Password is separate from the passwords for individual user accounts, including any accounts 
that you create for yourself and then use to develop and test your project. ) 

 Click Next and define the type of Project security. 

 Click Next and click Create/Configure Groups if you want to create or configure groups and then 
configure the settings as needed. 
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 Click Next and If you want to create or configure users, click Create/Configure Users and 
then configure the settings as needed. 

 
 Click Next and Review your configuration, and then click Finish to close the wizard. 
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10.1.3 Group and user Configuration 

10.1.3.1 User Group  

 In the Global tab of the Project Explorer, right-click Groups and then click Groups properties on 

the shortcut menu. 

 

 Group Account: The user group that you are currently configuring.  
 New: Creates a new group. In the New Group Account dialog, type the name of the new 

group and then click OK.  
 Delete: Deletes the currently selected group.  
 Reset: Resets the privileges of the currently selected group to match the (Default Rights) 

group.  
 Runtime Access:  
 The specific rights that a member of the group has when they use a project thin client to 

access your project during run time:  
 Security Rights: Locks the run-time privileges of the currently selected group to those 

configured for the (Default Rights) groupSecurity Level. 
 Access Level: The range of access levels that this group may access in the project.  
 Start Project: Members of the group may run the project.  
 Close Project: Members of the group may stop the project.  
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 Database Spy (write): Members of the group may write values to the project database 
using the Database Spy window.  

 Task switch enabled: Members of the group may switch away from the project runtime 
client to another Windows task.  

 Edit Security System: Members of the group may make changes to the project security 
system during run time.  

 Windows Task Manager: Members of the group may open the Windows Task Manager.  
 Enable Remote Security System and Remote Debugging Tools: Members of the group 

may:  

 Configure the security system in another project (running in Distributed - Client 
mode) in order to use the settings in the current project (running in Distributed - 
Server mode);  

 Configure a TCP/IP Client worksheet in another project in order to connect it to the 
current project; and  

 Use Remote Database Spy and Remote LogWin to debug the project while it is 
running on remote station.  

 Runtime group: If this option is selected, the group will be available for new users created 
during run time  

 Web Thin Client Access: Members of the group may use a web thin client to connect to the 
project runtime server.  

 Secure Viewer Access: Members of the group may use a Secure Viewer thin client to 
connect to the project runtime server.  

 Engineering Access  

 The specific rights that a member of the group has when they use the project 
development software to open and edit your project:  

 Security Rights: Locks the development privileges of the currently selected group to 
those configured for the (Default Rights) group. If changes are made to the (Default 
Rights) group, they also apply to this group.  

 Security Level: The range of access levels that this group may access in the 
development application.  

 Project Settings: Members of the group may modify the project settings and the 
Mobile Access configuration.  

 Drivers, Data Sources: Members of the group may create, modify device drivers and 
external data sources.  

 Network Configuration: Members of the group may create, modify TCP/IP Client 
worksheets.  

 Create, modify tags: Members of the group may create, modify project tags.  

 Create, modify screens: Members of the group may create, modify project screens.  

 Create, modify task sheets: Members of the group may create, modify task 
worksheets.  
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 Advanced: Opens the Group Account Advanced dialog. 

 

 

 In that you can define Min password size, Min number of special characters, Min 
number of numeric characters, Min number of alpha characters, Case-sensitive ( 
passwords created with both upper and lowercase characters must be entered the 
same way by the user) ,Password aging(The number of days that a password can be 
used before it expires),E-signature time-out(Timeout period (in minutes) of the E-Sign 
dialog box for all users in this group),Disable e-signature(When the value in this box is 
TRUE (non-zero), users in this group can ignore the e-signature requirement on any 
screen objects) ,Log Off after Number of (Counting from logon or Counting from user's 
last action ), Disconnect Web Thin Client on auto logoff, Auto Lock-up Enable , Lock up 
account after(Maximum number of times a user can try to log on to an account),Reset 
counter after(Defines how long after an invalid log-on attempt the project will wait (in 
minutes) until it resets the log-on attempts counter). 
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10.1.3.1 User Group  

 To create and maintain accounts for project users, click the Users button on the 
Security System dialog.  

  
 Create a new user: click New to open the New User Account dialog.  

 Delete a user: click the User combo-box button, select the user name from list, and 
then click Delete. 

 User Full Name text box: Type the user's full name.  

 New Password text box: Type the user's password.  

 Confirm Password text box: Re-type the user's password.  

 Block User: Block the user from logging onto the project at all, select User is blocked. 
This allows you to disable a user account without deleting it. 

 Runtime user: If this option is not selected, the user cannot be changed, blocked, or 
removed except through this dialog. This allows you to protect certain users. 
 

10.2 Protecting Your Intellectual Property 

10.2.1 Assigning a password to a single file 

To assign a password to a single project file:  

1. In the Project Explorer, find and right-click the desired file, and then click Password 
Protection on the shortcut menu. The Edit Protection dialog is displayed.  

2. Type the new password, and then type it again to confirm.  
3. Click OK to close the dialog.  
4. The file is now protected. The next time you try to open it, you will be prompted for 

the password. 
5. To clear the password, open file for editing, right-click the file in the Project Explorer 

and then click Password Protection on the shortcut menu. In Edit Protection dialog 
Leave the New password and Confirm password boxes empty. 
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10.2.2 Assigning a password to all file 

1.  On the Home tab of the ribbon, in the Tools group, click Verify. The Verify Project 
dialog is displayed.  

2. Click Set password for all files. The Edit Protection dialog is displayed.  
3. Type the current password for your project, if any.  
4. Type the new password, and then type it again to confirm.  
5. Click OK. The verification routine proceeds.  
6. Click Close to close the Verify Project dialog. 
7. To clear the password, again do the same Leave the New password and Confirm 

password boxes empty. 
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11. Remote Clients 

11.1 Mobile Access 

 Before configuring Mobile access publish the application. 

 Open Mobile access worksheet. 

 On the Project tab of the ribbon, in the Web group, click Mobile Access.  
 On the Graphics tab of the Project Explorer, double-click Thin Clients > 

Mobile Access.  

 The Mobile Access Configuration worksheet is opened for editing, with the tree view 
displayed on the left.  

 In the tree view, select the area for which you want to configure settings.  
 The Area Settings worksheet for that area is displayed. 

 
 In the General area, configure the general settings for the area.  

 In the Name box, type the name of the area as it should appear in the tree 
view.  

 In the Label box, type the area label that should be displayed in the Mobile 
Access web interface during run time.  

 In the Access Level box, type the minimum security level that the user must 
have in order to access the area during run time.  

 In the Alarms area, specify which alarms should be displayed in this area's Alarm 
control during run time. By default, all areas of the Mobile Access web interface will 
display all alarms that are configured in your project's Alarm worksheets. 
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 In the Trend and Process Values area, configure the process values that you want to 
display in this area and how they should be displayed. 

 In the Screens area, specify which project screens should be made available through 
this area's Screens control. 

 Save and close the Mobile Access Configuration worksheet.  

 go to “Control Panel”, then select “System and security” and select “Administrative 
Tools”.  

 This will open a new window. Double click on “Internet Information Services (IIS) 
Manager”. 

 

 Go to sites> Default Web site> MA and Browse.(Make sure your Run time is running.) 

 

 Give User name and password. 
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11.2 Web Thin Client 

 Before you start configuring Web thin client for remote access in ITME Web Studio 
make sure to completely turn off “Windows Firewall” and “Antivirus” from the 
computer in which the ITME application is running and from the computer you want 
to do remote access.  

 Now to access the ITME project remotely, the project needs to be published in HTML 
since, Web thin clients supports HTML5 pages for remote access. 

 Open the ITME Project that you want to access remotely.  
 Now in your ITME Web Studio application, click on the Startup icon on the top-left 

corner.  
 Go to “Publish” and select “Save All as HTML”. 

 
 

 Next, we need to setup some features and users in Windows Operating System using 

Internet Information Services (IIS) to enable remote access capabilities.  
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 Go to “Control Panel”, select “Programs” and then click on “Turn Windows features 

on or off”. 

 
 This opens up a new window which lists all the “Windows Features”.  

 Here we need to turn on all the features under “Internet Information Services”, so 

expand all the options under “Internet Information Services” and check the box in 

front of all the options to select them. 
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 Now, click “OK” and wait for the features to turn on. It will take a couple of minutes. 

 Again, go to “Control Panel”, then select “System and security” and select 

“Administrative Tools”.  

 This will open a new window. Double click on “Internet Information Services (IIS) 

Manager”. 

 
 In “Internet Information Services (IIS) Manager” window, double click on “MIME 

Types”. 

 
 On the right side at the top click on “Add”. In the Add MIME Type window enter the 

following: File name extension: .* MIME type: application/studio  

 MIME types should include all file extensions found in the Web directory. These 
include:  

 .app  
 .bin  
 .csv  
 .gis  
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 .html  
 .ico  
 .ini  
 .lst  
 .rtgis  
 .scc  
 .scr  
 .sg  
 .stmp  
 .tra  
 .txt 

 
 Double click on your PC name”……………….” on the top left hand side and then double 

click on “Sites” and select “Default Web Site”.  

 Now select the users that you just created in the “Groups or user names list” one by 

one and click on the check box for “Full Control” in “Permissions for ……………”. Do 

this for both IUSRS and IIS_IUSRS. 

 Click “Apply” and then click “OK”.
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 Now click on “Basic Settings”. 

 
 In the new popped up window click on the “Browse button” and select the path of 

the ‘Web’ folder of your ITME application that you want to access remotely. Click 

“OK” and again “OK”. 

 Check test connection, if it does not get succeeded, select connect as and give the 

system user name and password. 
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 Change the IP address of your computer from which you want to remotely access 

the application so that it is in the same network as the computer’s IP address 

running the application. 

 
 To remotely access the application it is necessary that the application is running. So, 

go to the ITME application and click on “Run” under “Home tab – Local 

Management". 

 

 
 Now open “Internet Explorer”, and type: 

http://<IP Address>/<Home Screen name>.html 

Ex: http://192.168.11.164/Screen1.html 

 

 

 

 

 

 

http://192.168.11.164/Screen1.html
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12. Using Databases 

12.1 The Project Database 

All Project database tags are organized into one of the following categories, which are 

represented by folders on the Global tab of the Project Explorer: 

 Project Tags are tags that you create during project development. 

 System Tags are predefined tags with predetermined functions that are used for 

ITEH supervisory tasks. 

 Shared Database folder only shows the integrated tags that you have already added 
to your project. If you have not set up any tag integration sources and then used the 
Object Finder to select specific tags, the folder will be empty. 

12.2 Database/ERP Task 

To create a new connection to a target database:  

1. In the Project Explorer, open the Database/ERP folder and then right-click on 
Connections.  

2. Choose Insert from the shortcut menu.  
3. In the Name field, enter the name that you want to use to reference the target 

database. You can create multiple database connections, but each connection must 
have a unique name.  

4.  

mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/topics/Application_Tags_Folder.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/topics/Database_Tab_System_Tags_Folder.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/topics/projectexplorer.html


 

  

SSM INFOTECH SOLUTIONS PVT. LTD. 77 

 

INTOUCH MACHINE EDITION BASIC LEARNING 

5. In the Connection String field, click the browse button … to open a standard Data 
Link Properties dialog. Use the dialog to configure a connection string for the target 
database.  

6. In the User Name and Password fields, enter an appropriate login for the target 
database. The login should already be created on the database server, and it should 
have enough privileges to read from and write to the database tables.  

7. Click OK to close the dialog and save the connection configuration.  
8. Right-click on the Database/ERP folder in the Project Explorer, and then click Insert 

on the shortcut menu. 

 
9. Description field: Enter a description of the worksheet, for documentation purposes.  
10. Status field: Enter the name of a numeric tag that will receive status codes for 

database operations during runtime 
11. Completed field: Enter the name of a numeric tag that will be toggled when 

database commands are successfully executed.  
12. Error Message field: Enter the name of a string tag that will receive detailed error 

messages, if errors occur during runtime.  
13. Connection combo-box: Click to select a connection to the target database. All 

available connections are listed, as configured with the Database Connection dialog 
described above.  

14. Type combo-box: Click to specify how the result set will be selected for the 
worksheet:  

1. Table: Enter a table name and an optional filter condition. (The filter 
condition is equivalent to the SQL "Where" clause.) All rows of the table that 
match the filter condition are selected.  

2. SQL: Enter a custom SQL "Select" statement.  
15. Insert field: Enter any tag; when the value of the tag changes, a new row is inserted 

with the current values of the tags configured in the worksheet body.  
16. Update field: Enter any tag; when the value of the tag changes, all rows of the result 

set are overwritten with the current values of the tags configured in the worksheet 
body.  

mk:@MSITStore:C:/Program%20Files%20(x86)/Wonderware/InTouch%20Edge%20HMI%20v8.1/Bin/TechRef.chm::/references/r_worksheet_tasks_database.html#topic8191__section_BBE389499C6D4578B0A0ECCC8D755B04
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17. Delete field: Enter any tag; when the value of the tag changes, all rows of the result 
set are deleted. 
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13. Integrating With Other Wonderware Products 

13.1 Wonderware Historian 

 Right-click the Trends folder in the Project Explorer, and then click Insert on the 
shortcut menu. In history format select historian. 

 Select historian configuration. In the settings for the selected connection type are 
displayed.  

 
 

 In the Server box, type the host name or IP address and port number of the Historian 
database server. For example, HistorianDBServer:32568.  

 The port number is optional. If you did not change the port number in the 
Historian database settings, you can omit it here and the default (port 32568) 
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will be used. Otherwise, the port number must match the one that is 
specified in the Historian database settings.  

 In the User and Password boxes, type your credentials to access the Historian 
database.  

 In the Database Settings area, in the Prefix box, type a prefix that will be added to 
the tags saved in the database in order to keep them grouped together. For 
example, if you are configuring the connection for Trend worksheet TREND001, you 
could make that the prefix as well.  

 If you want to store historical data when the connection is unavailable and then 
forward the stored data when the connection is reestablished, select Enable store 
and forward.  

 The historical data will be saved in your project folder (on the project runtime 
server). Please note that this can consume a large amount of hard drive space 
if the connection is unavailable for a long time.  

 In the Run-time area, in the Status box, type the name of a project tag (Integer type) 
that will receive codes describing the status of the connection during project run 
time.  

 In the Gateway area, in the Host and Port boxes, type the host name or IP address 
and port number of the database gateway that your project will use.  

 Click OK to save the settings and close the dialog box. 

 


